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ABSTRACT

Energy from renewable sources such as solar and wind are gaining interest as the world’s power demands
increase and non-renewable resources deplete. A large component of energy expended in the world is used by
industries and houses that are connected to the electrical grid. Thus attempts are being made to raise the
percentage of energy sourced from renewable sources in the grid. Photovoltaic (PV) energy sources are
considered quintessential factor in increasing this percentage due to ubiquitous nature of solar power and absence
of any moving parts and hence extended life time.

i e
W = —
“ = Y
|

=

Photovoltaic DC-DC Boost Single Phase Grid /
Panel With MPPT Inverter 4

Fig 1 PV Grid Tied Inverter

Fig 1 shows a typical PV inverter system that feeds power into the gird. A variety of power topologies are used for
different PV systems depending on power level and system requirements. The Texas Instruments C2000
microcontroller family, with its enhanced peripheral set and optimized CPU core for control tasks, is ideal for these
solar power control applications. This guide presents a PV Inverter system software, which implements all the key
features needed by a PV inverter system like MPPT, closed loop current control of inverter and grid
synchronization using C2000 MCU. The guide uses the Solar Explorer Kit (TMDSSOLARPEXPKIT) platform to
illustrate the system with a F28035 control card.
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1 INTRODUCTION

PV Inverter system has its unique set of challenges, to name a few: as PV panel have a non linear V vs |
characteristics the PV system must make sure that it operates at the maximum power point (MPP) of this curve
and feed the maximum power it can into the grid. To feed current into the grid as PV is a DC source an inverter is
necessary for DC-AC conversion. Also, for the inverter to be able to feed power into the grid it must maintain a DC
bus greater than the max instantaneous voltage of the grid, thus a boost stage from the PV output voltage may be
required. In addition to this the current that the inverter feeds into the grid must be clean and in phase. A
combination of hardware and software is used to tackle these challenges. Though the exact power stages vary
depending on the PV power rating and other regulatory factors a typical PV inverter can be thought of as consisting
of two power stages as shown in Fig 1:

i. DC-DC stage for boosting the voltage and tracking the MPP of the panel.

. DC-AC stage for conversion to AC and to feed current into the grid

1.1 Solar Explorer Kit

Solar Explorer Kit is a low voltage platform to evaluate C2000 microcontroller family of devices for renewable
energy applications such as PV inverter. Fig 3 gives a block diagram of different stages present on the Solar
Explorer kit that are used for the PV inverter system The input to the solar explorer kit is a 20V DC power supply
which powers the controller and the supporting circuitry. A 50W solar panel can be connected to the board
(Typical values Vmpp 17V, Pmax 50W). However for quick demonstration of the power processing, a PV emulator
power stage is integrated on the board along with other stages that are needed to process power. The control of
the PV panel is kept separate from the control of the other stages. PV is light dependent source, the PV panel
emulator can be used to test PV inverter under changing lighting conditions. As the control of PV panel is
executed on a separate controller a SPI link is added from the DIMM100 on the solar explorer to the PV Panel
emulator controller. This simplifies the debug and demonstration. Details on the hardware and power stages
present on the board can be found at: Details on the hardware and power stages present on the board can be
found at:

controlSUITE\development_kits\
SolarExplorer_vx.x\~Docs\SolarExplorer_HWGuide.pdf

The Solar Explorer kit can be used to implement a PV inverter system by connecting the power stages as shown in
Fig 2.
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Fig 2 PV Inverter using Solar Explorer Kit
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Fig 3 Solar Explorer Kit Power Stages for a typical PV Inverter System

DCDC Boost with MPPT

Input to this stage can come from Panel emulator block or externally connected solar panel. Fig 4 shows the
power stage circuit implemented on solar explorer kit for this stage. Inductor L1, MOSFET switch Q1 and diode
D1, together form the boost circuit. The boost circuit operates at 100 KHz. Fig 5 illustrates the control scheme for

the DC-DC Boost stage with MPPT.
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Fig 4 DC DC Boost stage power circuit
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Fig 5 Control of DC-DC Boost with MPPT

DC-AC Single Phase Inverter

A full bridge inverter is used to generate single phase AC waveform. Input to this block is from DCDC Boost
power stage. Inverter stage operates at 20Khz. Switches Q1, Q2, Q3, Q4 form the full bridge inverter. These,
together with LCL filter, generate filtered single phase AC output.
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Fig 6 DCAC inverter stage power circuit

1.2 Gird Tied PV Inverter Control Diagram

Fig 7 illustrates the control scheme for a grid connected PV inverter. It is clearly noted that there are two Interrupt
Service Routines (ISRs) one for closed loop control of the DC-DC stage(50Khz, every alternate switching period)
and other for the closed loop control of the inverter stage(20Khz). Functions such as MPPT, gird synchronization
are also required. All these key functions are implemented on the F28035 MCU for the Solar Explorer Kit.
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Fig 7 Control of Grid Tied PV Inverter System



2 Software & Control Description

This section describes the details of PV Inverter control and software for the Solar Explorer kit.

2.1 Project Framework

As shown in Fig 7 PV inverter control requires two real time ISR’s on is the for the closed loop control of the DC-DC
stage and the other for the closed loop control of the DC-AC stage. The C2000 Solar Explorer Kit project makes use
of the “C-background/C-ISR/ASM-ISR” framework. The fast ISR (100kHz), controlling DC-DC Boost stage, runs in
assembly environment using the Digital Power Library and slower ISR (20kHz), controlling DC-AC inverter, is run
from the C environment. This DC-AC ISR is made interruptible by the DC-DC ISR. The project uses C-code as the
main supporting program for the application, and is responsible for all system management tasks, decision making,
intelligence, and host interaction.

The key framework C files used in the project are:

SolarExplorer-Main.c — this file is used to initialize, run, and manage the application. In addition, this file also
contains ISR for inverter stage control, MPPT algorithm execution, data logging and relay control etc.

SolarExplorer-Devinit_F2803x.c — This file contains all the initialization routines and configuration of 10s and
peripherals for this application. This file also includes functions such as setting up the clocks, PLL, Watchdog etc.
Most of functions in this file are called once during system initialization from SolarExplorer-Main.c.

SolarExplorer-Settings.h — This file contains of setting such as incremental build option and various defines for
PWM frequency, ISR triggers that are used in the project framework.

SolarExplorer-Includes.h — This file contains of all the header files used by the project.

SolarExplorer-DPL-ISR.asm — This file contains time critical “control type” code. This file has an initialization
section (one time execute) and a run-time section which executes at half the rate (50kHz) as the PWM time-
base(100kHz) used to trigger it. This is used for the fast DC-DC boost closed loop control.

Other important include files: (more details can be found in Solar Library documentation)

SPLL_1ph.h — This files contains code for calculating grid angle while connected to the grid and used in inverter
stage control.

SineAnalyzer_diff.h - This file contains code for calculating the RMS voltage and frequency of the input line voltage.
This file has an initialization section (one time execute) and a runtime section which executes at 10kHz rate.
mppt_incc.h: This file contains code for incremental conductance algorithm used for tracking MPPT.

mppt_pno.h: This file contains code for perturb and observe algorithm used for tracking MPPT.

Fig 8 gives the structure of the PV inverter software, with the main background loop, the DC-DC ISR and the DC-
AC ISR.



(ii) DC-AC Inverter ISR (20Khz)
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Fig 8 PV Inverter Software structure (i) Main loop (ii) Inverter stage ISR (iii) DCDC Boost stage ISR



2.2 Project Dependencies & Resources

Hardware Kit : TMDSSOLARPEXPKIT [R5]
Control Card : F28035
Software IDE : CCSv4.2.4 or later

Control Suite Dependencies

Device Support (F28035 Header Files) i controlSUITE\device_support\£f2803x\v125

IQMath Library scontrolSUITE\libs\math\IQmath\v160

SGEN Lib icontrolSUITE\1ibs\dsp\SGEN\v101

Digital Power Library icontrolSUITE\app_libs\digital_power\f2803x_v3.3
Solar Library :controlSUITE\app_libs\solar\v1l.0\IQ

Drivers lcontrolSUITE\app_libs\drivers\vl.0\F2803x

The guide assumes that the user has already read the following documents related to the kit:

controlSUITE\development_kits\SolarExplorer\~Docs\SolarExplorer_HWGuide.pdf

The above documents discuss the kit's hardware features and power stages.

2.3 Control Description

Fig 7 shows the control of a grid tied PV inverter, which comprises of closed loop control of the boost and closed
loop control of the inverter. Following sections gives details of the software flow for these two modules.

DC-DC Boost with MPPT Control Software

To get the most energy out of the solar panel, panel needs to be operated at its maximum power point. Maximum
power point however is not fixed due to the non linear nature of the PV cell and changes with temperature, light
intensity etc. Thus different techniques are used to track maximum power point of the panel like Perturb and
Observe, incremental conductance algorithms. These techniques try to track the maximum power point of the panel
under given operating conditions and are thus referred to as Maximum Power Point Tracking (MPPT)
techniques/algorithms. The Solar Explorer kit has a front-end boost converter to boost the input voltage from the
solar panel to a suitable level for the inverter and track the MPP, Fig 4.

The control of the stage is described in Fig 5. To track the MPP, input voltage (V,,) and Input Current (l,,) are
sensed. The boost converter is a traditional single phase converter with a single switching MOSFET Q1. The duty
cycle of the PWM output driving the Q1 MOSFET switch determines the amount of boost imparted is the controlled
parameter. The MPPT is realized using nested control loops, an outer voltage loop that regulates input DC voltage
(Vo) and an inner current loop that controls the current of the boost stage. Increasing the current reference of the
boost, i.e. current drawn through the boost loads the panel and hence results in the panel output voltage drop.
Therefore the sign for the outer voltage compensator reference and feedback are reversed. The current and voltage
controllers are executed at a rate of 50 kHz (half of the PWM switching frequency) while the MPPT controller is
executed at a much slower rate ~ 10Hz. It is noted from Fig 5 that the boost stage output voltage is not being
controlled through software. Boost output voltage however is regulated by the DC-AC inverter, which modulates the
current drawn by the inverter to keep this voltage regulated. However, for protection the output of the boost is
connected to ADC pin with and internal comparator that can be used to trip the PWM to the DC-DC stage in case of
over voltage.
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Fig 9 DC-DC 1ph Boost with MPPT Software Diagram

As switching rate of the DC-DC stage is fairly high 100Khz, the control ISR for the DC-DC is implemented in an
optimized assembly ISR (ASM — ISR) which uses components from the Digital Power Library. In the PV inverter
project the DC-DC ISR is invoked every alternate switching cycle, this is done because PV panel output does not
change very fast. Fig 9 gives the software diagram for the DC-DC stage using the optimized blocks from the digital
power library.

The ADC result registers are read by the ADCDRV_1ch block and converted to normalized values and stored in
variables lpvread, Vpvreads lboostswread @Nd Vioostreas: TWO 2-pole 2-zero controllers(CNTL_2P27) are used to close the
inner DC-DC boost current loop and the outer input voltage loop. MPPT algorithm provides reference input voltage
to the boost stage to enable panel operation at maximum power point. The sensed input voltage is compared with
the voltage command (Vprr), generated by MPPT controller, in the voltage control loop. The voltage controller
output is then compared with the output current (lpoostswreasy fe€dback in the current controller. Current loop
controller’s output decides the amount duty to be imparted to the PWM so as to regulate the input voltage indirectly.
The PWMDRV_1ch_UpDwnCntCompl block is used to drive the DC-DC stage. Panel current and voltage are
filtered using the MATH_EMAVG block, this is done to remove any noise on the panel current and voltage sensing
that may confuse the MPPT algorithm.



Notice the color coding for the software blocks. The blocks in ‘dark blue’ represent the hardware modules on the
C2000 controller. The blocks in ‘blue’ are the software drivers for these modules. Blocks in ‘yellow’ are the controller
blocks for the control loop. Although a 2-pole 2-zero controller is used here, the controller could very well be a
PI/PID, a 3-pole 3-zero or any other controller that can be suitably implemented for this application. Similarly for
MPP tracking, users can choose to use a different algorithm.

Code snippet below shows the Input/Output connections between the different blocks used from the Digital Power
Library to implement the DC-DC Boost MPPT control software, this can directly be related to the control diagram
above.

PWMDRV_1ch_UpDwnCntCompl_Duty3 = &Duty3A;

ADCDRV_1ch_Rltl=&IboostswRead;
ADCDRV_1ch_R1t5=&VboostRead;
ADCDRV_1ch_R1lt6=&IpvRead;
ADCDRV_1ch_R1t7=&VpvRead;

// MATH_EMAVGl block connections
MATH_EMAVG_Inl=&IpvRead;
MATH_EMAVG_Outl=&IpvRead_EMAVG;
MATH_EMAVG_Multiplierl=_TIQ30(0.001);

// MATH_EMAVG2 block connections
MATH_EMAVG_In2=&VpvRead;
MATH_EMAVG_Out2=&VpvRead_EMAVG;
MATH_EMAVG_Multiplier2=_IQ30(0.001);

//connect the 2P2Z connections, for the inner current Loop
CNTL_2P27_Ref2 = &IboostSwRef;

CNTL_2P27_0Out2 &Duty3A;

CNTL_2P2%7_Fdbk2= &IboostswRead;

CNTL_2P2%Z_Coef2 = &CNTL_2P27Z_CoefStruct2.b2;

//connect the 2P27Z connections, for the outer Voltage Loop
CNTL_2P27_Refl = &VpvRead;

CNTL_2P2Z_Fdbkl = &VpvRef;

CNTL_2P27_0Outl = &IboostSwRef;

CNTL_2P27_Coefl = &CNTL_2P27Z_CoefStructl.b2;

The Run time ISR is found in the DPL-ISR.asm file, which consists of just calling the run time macros from the
digital power library. The MPPT algorithm is called from a background task in the background C framework.

DC-AC Single Phase Inverter Control Software

Inverter stage gets input from the DC-DC boost stage as shown in Fig 3 and the inverter converts DC into AC.
Inverter can be operated in off-gird or grid-tie configuration.

For a full bridge inverter it can be noted that when using unipolar modulation the current fed is given by the equation:

_ (Vdc - Vgrid )D + (O - vgrid )(1 - D) _ Vdc * D - vgrid

Aigrid -
ZLCL (st) ZLCL (st) ZLCL (st)

Where D is the duty cycle.



It is clear from the equation that for the inverter to be able to feed current into the grid the Vdc must always be
greater than the max grid voltage. Also it's known from Fig 5 that the DC bus is not regulated by the DC-DC boost
stage. Therefore the Inverter stage software uses nested control loops — an outer voltage loop and an inner current
loop. Voltage loop generates the reference command for the current loop, as increasing the current command will
load the stage and hence cause a drop in the DC bus voltage the sign for reference and the feedback are reversed.
The current command is then multiplied by the AC angle to get the instantaneous current reference. In case of “off-
grid” configuration sine reference is generated using SGEN library function which provides the angle value whereas
for grid connected software PLL provides the grid angle. The instantaneous current reference is then used by the
current compensator along with the feedback current to provide duty cycle for the full bridge inverter. The outer
voltage loop is only run at ZCD of the AC to prevent any distortion in the current. Fig 10 and Fig 11 show the
software diagram for the inverter control under grid-tie and off-grid configurations
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Fig 10 Closed Loop Current Control for DC-AC with grid connection
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2.5 DC-DC and DC-AC Integration

As shown in Fig 7 PV inverter control requires two real time ISR’s one is the for the closed loop control of the DC-
DC stage(100Khz) and the other for the closed loop control of the DC-AC stage(20Khz). The peripheral i.e. ADC
and PWM’s on the C2000 device family have been designed to integrate multi frequency control loops and
guarantee sampling at correct instances of the PWM waveform. However as only one ADC present (two sample
and holds) it needs to be guaranteed that the multi rate ISRs do not conflict for the ADC resource at any instance.
For this the phase shift mechanism of the PWM'’s on the ePWM peripheral is employed. Fig 12 illustrates the timing
diagram for configuring the EPWM for the inverter and the boost stage and the synchronization mechanism used to
avoid ADC conflicts.
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Fig 12 Timing diagram for Boost and Inverter Integration



The above diagram illustrates the PWM waveform generation on a 60MHz device for 20KHz DC-AC Inverter and a
50KHz control loop rate of the DC-DC boost with MPPT stage(note the switching rate is 100KHz). The PWM
peripheral offers the flexibility to trigger Start of Conversions (SOC’s) for the ADC every switching cycle or alternate
thus avoiding any unnecessary load on the ADC.

In addition to this a phase shift is implemented to avoid any conflict on the ADC resource. A phase shift of 30 clock
cycles is chosen to account for 7 cycle sampling window and 15 cycle first conversion delay.

As the DC-DC control loop is given priority and the DC-DC ISR can be serviced from the DC-AC ISR through
nesting of interrupts.



3 Hardware Platform Setup

3.1 HW Setup Instructions

Note: Do not power up the board before you have verified these settings!
Before starting the labs the user must make sure the following settings are correct.

1) Make sure nothing is connected to the board, and no power is being supplied to the board.
2) Insert the controlCARD into the [Main]-J1 controlCARD connector if it is not already installed.
3) Do the following switch settings on the control CARD:

a. Control Card SW1 is in the OFF position

b. Control Card SW2, Position 1 = ON, Position 2 = ON

[M7]-JP1 USB [M6]-JP1 DC [M6]-SW1 in ON
Cable to Host Power Jack [M6]-J1 position

[M7]-J4 — " I\ﬁnana cable
ain]-BS1 to
; [Main]-BS3
[Main]-J4-— »
[Main]-J1, |
J2,J3

50W Bulb mounted
on Machined Socket

@@@

Texas Instruments ‘5 g
Solar Explorer Kit [RS] —

4 :
N B .
Fig 13 Hardware setting Solar Explorer Kit

4) The guide assumes that the TMS320F28027 microcontroller present in the M4 macro is pre-flashed with the
panel emulator code with which the kit is shipped.

5) Connect a banana cable between [Main]-BS1 and [Main]-BS3

6) Connect a banana cable between [Main]-BS4 and [Main]-BS5



7) Verify the 50W bulb is in the bulb holder in the [M2] macro.

8) Make sure the [Main]-J1, [Main]-J2, [Main]-J3, [Main]-J4, [M6]-J1 and [M7]-J4 jumpers are populated. Verify
[M6]-SWH1 is in on position.

9) Connect a USB cable (B to A Cable) from [M7]-JP1 to the host computer. [M7]-LD1 will light up indicating that
the USB is powered.

10) Now connect the DC power supply shipped with the kit to [M6]-JP1, and turn on [M6]-SW2. [M5]-LD2 will start
blinking indicating the PV emulator code is running on the emulator. Turn off [M6]-SW2.

3.2 Software Setup

Installing Code Composer and controlSUITE

1. If not already installed, please install Code Composer v4.x from the DVD included with the kit.

2. Go to http://www.ti.com/controlsuite and run the controlSUITE installer. Select to install the “SolarExplorer”
software and allow the installer to also download all automatically checked software.

Setup Code Composer Studio to Work with SolarExplorer kit

3. Open “Code Composer Studio v4”.

4. Once Code Composer Studio opens, the workspace launcher may appear that would ask to select a workspace
location,: (please note workspace is a location on the hard drive where all the user settings for the IDE i.e.
which projects are open, what configuration is selected etc. are saved, this can be anywhere on the disk, the
location mentioned below is just for reference. Also note that if this is not your first-time running Code
Composer this dialog may not appear)

Click the “Browse...” button

Create the path below by making new folders as necessary.

“C:\Documents and Settings\My Documents\ CCSv4_workspaces\ProjectWorkspace”
Uncheck the box that says “Use this as the default and do not ask again”.

Click “OK”.



¥ Workspace Launcher

X

Select a workspace

Code Composer Studio stores your projects in a folder called a workspace.,
Choose a workspace folder to use for this session.

YWorkspace: | C:\MyWorkspacesworkspace 1 v| [ Browse...

[ Juse this as the default and do not ask again

K, ] [ Cancel

Fig 14 Open new workspace

5. Next we will configure Code Composer to know which MCU it will be connecting to. Click “Target -> New Target

Configuration...”. Name the new configuration xds100-f28035.ccxml. Make sure that the “Use shared location”
checkbox is checked and then click Finish.

¥ New Target Configuration @

Target Configuration

Create a new Target Configuration File,

File name: | xds100_F23035, coxml |

A Use shared location

Location: | C\Documents and Settingsiusernamepuser\CCSTargetConfigurations | [Browse... ]

@ |

Finish H Cancel ]

Fig 15 New Target Configuration for XDS100 v1 and F28035 MCU

A new tab will now appear. Select and enter the options as shown:

=  Connection — Texas Instruments XDS100v1 USB Emulator
= Device — TMS320F28035
=  (Click Save

= Close the xds100-f28035.ccxml tab



Basic

General Setup Advanced Setup

This section describes the general configuration about the target. |

Connection |Texas Instruments ¥D5100v1 USE Emulatar v | Target Configuration : lists the configuration options For the target,

Device | Faanag | B

Save Configuration

[] Develaper's Kit - Dual Makar Cortral and PFC (F28035)
[] peveloper's Kit - Mokar Control and PRC (F28035)

[] Experimenter's Kit - Piccolo F28035

TMS320F28035

Moke: Support For more devices may be available from the update manager.

Fig 16 Target Configuration Settings

7. Assuming this is your first time using Code Composer, the xds100-F28035 configuration is now set as the

8.

default target configuration for Code Composer. Please check this by going to*View->Target Configurations”. In
the “User Defined” section, right-click on the xds100-F28035.ccxml file and select “Set as Default”. This tab also
allows you to reuse existing target configurations and link them to specific projects.

Add all the solar projects into your current workspace by clicking “Project->Import Existing CCS/CCE Eclipse
Project”.

= Select the root directory of the SolarExplorer. This will be:
“\controlSUITE\development_kits\SolarExplorer_v1.0\SolarExplorer_PVInverter_F2803x”

P Import CCS Eclipse Projects @

Select Existing CCS Eclipse Project —=
Select a directory to search for existing CCS Eclipse projects. E ;
-

(® Select search-directory: |IJ'ﬁolarEprorer_P'-;'In\.-'erter_F2803><| |[ Browse.., ]

(O select archive file: i |

Discovered projects:

T SolarExplorer_PVInverter_F2803x {C:\Documents and Select All

Deselect Al

£

([

|:| Copy projects into workspace

7 I
\7)

Finish H Cancel ]

Fig 17 Adding F28035 PV Inverter project to the workspace



= Click Finish, this would copy all the projects relevant for the kit into the workspace. If you want only a
particular project to be copied uncheck the box next to the other project names.

Configuring a Project

9. Expand the file structure of the project you would like to run from the C/C++ Projects tab. Right-click on this
project’'s name and select “Set as Active Project”, if this is not already the case.

10. Assuming this is your first time using Code Composer, the xds100-F28035 should have been set as the default
target configuration. Do verify this by viewing the xds100-f28035.ccxml file in the expanded project structure
and a [Active/Default] written next to it. By going to “View-> Target Configurations” you may edit existing target
configurations or change the default or active configuration. You can also link a target configuration to a project
in the workspace by right clicking on the Target configuration name and selecting Link to Project.

11. Fig 18 shows the project in the CCSv4 C/C++ Project tab, it shows all the key files used in the project.

=} SolarExplorer_PVInverter F2B03x [Active - F2803x_FLASH]
{} Binaries

é Includes

= ~Docs

[E=- F2803x_FLASH

[ src commros

@ SolarExplorer-Includes.h

@ SolarExplorer-Settings.h

[ ADC_sOC_cnf.c

[£) DSP2303x_CodeStartBranch.asm
[} D5P2303x_GlobalvariableDefs.c
@ DSP2803x_usDelay.asm

@ PWM_1ch_UpDwnCrntCompl_Cnf.c
@ SolarExplorer-DevInit_F2303x.c
@ SolarExplorer-DPL-ISR. asm

@ SolarExplorer-Main.c

[5y Util_DLOG4CHC. asm

BEL C28x_SGEN_Lib_fixed.ib

|45 DSP2803x_Headers_nonBIOS,cmd
| g F28035_FLASH_SolarExplorer, CMD
|Z| Graph2.graphProp

By 1Qmath.lib

B commros_23xx_c_regular.lib

|Z| graph1.graphProp

|| macros.ini

[T xds100v1-f28035, coxml [Active]

S

LR R R R < 2 = R R R SR S|

Fig 18 PV Inverter project in C/C++ tab



4 PV Inverter Project

This project is divided into simplified incremental builds to run smaller subsystems of increasing complexity until the
target system is built up completely. This makes it easier to learn and get familiar with the board and the software. This
approach is also good for debugging/testing boards. The various build options are shown below. To select a particular
build option, set the appropriate value in the BUILD setting, found in the SolarExplorer-settings.h. Once the build option
is selected, compile the complete project by selecting rebuild-all compiler option. Next chapters provides more details
on how to run each of the build options.

Following are the build options supported on Solar Explorer kit.

Build 1: lllustrates closed current loop control of the Inverter Stage

Build 2: lllustrates MPPT & DC bus regulation along with closed current loop control of the Inverter Stage with a Bulb
Load at the putput of the inverter, and locally generated sine reference.

Build 3: lllustrates the grid connection of the PV inverter along with MPPT , DC Bus regulation and closed loop current
control of the inverter, a resistive load must be used (not shipped with the kit) for this build.

All software files related to this C28x controlled Solar Explorer system i.e., the main source files, ISR assembily files and
the project file for C framework, are located in the directory

...\controlSUITE\development_kits\SolarExplorer\SolarExplorer_PVinverter_F2803x.

4.1 BUILD =1
Inverter Current Control

Objective:

The objectives of this build are, (1) evaluate PWM and ADC software driver modules, (2) verify MOSFET gate driver
circuit, voltage and current sensing circuit, (3) Closed loop current control for the Inverter power stage, (4) become
familiar with the operation of Code Composer Studio (CCS). Under this build the system runs in closed-loop current
mode control for the Inverter power stage and DCDC boost stage is not active. Steps required for building and running a
project are explained next.

Overview:

The software in Build1 has been configured so that the user can quickly evaluate the PWM driver module, ADC drivers
and closed loop current mode control for the inverter by viewing the related waveforms on a scope. User can also
observe the effect of changing the current reference — as the closed loop control operation takes effect to track to the
set current reference command. The user can adjust the current reference command (inv_Iset) from CCS watch
window. The user can also evaluate the ADC driver module by viewing the ADC sampled data in the watch window. The
Sine Analyzer block calculates the RMS voltage and frequency of the output voltage. It also provides additional
information related to the zero crossing points, average value and the cycle information.
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Fig 19 Build 1 Control Software Diagram

The PWM and ADC driver macro instantiations are executed inside the SolarExplorer-Main.c file. Fig 19 shows the
software blocks used in this build. The quantities that are sensed and fed back to the MCU include - (1) the two inverter
leg currents (lleg1_fb, lleg2_fb) sampled at appropriate time instance and the difference saved as
inv_meas_cur_diff_inst, (2) Output AC voltage (Vac_FB) and (3) the DC bus voltage (VboostRead), not used in this
build.

PWM 1ph Inverter Unipolar Modulation: Four PWM’'s are needed to drive a full bridge inverter.
PWM_1phInv_unipolar_CNF(n,period,deadband_rising,deadband falling) macro, found in the driver library

controlSUITE\libs\app_libs\drivers\v1.0\F2803x

is used to configure the PWM1 and 2 for unipolar modulation where PWM1A and PWM1B drive one leg of the inverter
switches while ePWM2A and ePWM2B drive the other leg. 20Khz switching frequency is used for the inverter. With the
controller operating at 60MHz, one count of the time base counter of ePWM1 corresponds to 16.6667ns. This implies a
PWM period of 50us (20Khz) is equivalent to 3000 counts of the time base counter (TBCNT1, TBCNT2). Detailed
configuration of the PWM switches is shown in Fig 20. On a CAU event (TBCNT1 = CMPA and counting up), ePWM1A
output is Reset, while on a CAD event (TBCNT1 = CMPA and counting down), ePWM1A output is Set. ePWM1B is
generated using active high complementary mode deadband configuration. Hence, ePWM1A and ePWM1B are
complimentary outputs, with deadband (20 cycles) inserted, driving top and bottom switches of one inverter leg.
ePWM2A and ePWM2B are also generated in a similar fashion depending on the positive or negative cycle of operation
as shown in figure Fig 20.
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Fig 20 PWM generation and ADC sampling for inverter control

As switched current are sensed for the inverter current sampling is done at the midpoint of the PWM ON pulse. The
ADC module is configured to use SOCA of ePWM1 such that, SOCA is triggered at TBCNT1 = ZERO event. All other
conversions such as AC voltage and DC Bus sampling is also completed using this SOCA trigger.

Fig 21 shows how unipolar modulation is used to switch the four PWM'’s in positive and negative half cycle of the grid.

PWM

PWM

Unipolar Modulation
Fig 21 PWM control of inverter using unipolar modulation technique

The ADC gives a 12 bit result, as the inverter quantities are AC a few lines of code in the ISR implement the level
shifting and offset removal of AC line half cycle (positive & negative half cycles) current values obtained from lleg1-fb
and lleg2-fb and the Vac_FB signal. The inverter current feedback is then given to the pidGRANDOQO _linv and the output



is fed as duty to the PWMDRYV macro. Sign of the duty command is used to identify the output switching cycle (positive
or negative cycle) and configures the appropriate PWM output to switch the inverter leg (ePWM1 or ePWM2) to switch
either leg1 or leg2 determining the AC line half cycle at the output.

SGEN Module

The signal generator module from SGEN library (refer to SGEN library documentation at \controlSUITE\libs\dsp\SGEN)
is used for SINE generation. The frequency of the generated signal is reciprocal of the time it takes for successive
overflow of modulo counter, which in turn commensurate with the step value added to the counter. Thus by changing
the step value, one can precisely control the frequency. The step value is not directly commanded to vary the frequency,
instead the modulation of frequency is performed using the normalized variable “freq” which is normalized to the
maximum frequency. The maximum required frequency is predetermined based on the application requirement and it
set by initializing the “step_max” input. Thus, the normalized variable “freq” allows the user to control the frequency of
the signal between 0 to maximum frequency.

Code snippet below shows how to initialize sgen module to generate 50Hz sine wave.

/* Signal Generator module initialisation */
sgen.offset=0;
sgen.gain=0x7fff; /* gain=1 in Q15 */
sgen.freqgq=0x14F8CF92; /* freq = (Required Freq/Max Freq)*2"31 */
/* = (50/305.17)*2"31 = 0x14£f8cf92 */

sgen.step_max=0x3E7FB26; /* Max Freg= (step_max * sampling freq) /2732 */
/* =(0x3E7FB26*20k) /2732 = 305.17 */

sgen.phase=0x80000000; /* Phase=(required Phase) /180 in Q31 format */
/* = (+90/180) in Q31 = 8000h */

PID GRANDO Module

The PID_grando module implements a basic summing junction and PID control law with the following features (refer to
solar library documentation at ...\controlSUITE\libs\app_libs\solar):

e Programmable output saturation

e Independent reference weighting on proportional path

e Independent reference weighting on derivative path

e Anti-windup integrator reset

e Programmable derivative filter
All input, output and internal data is in 18Q24 fixed-point format.

Procedure

Assuming the hardware and setup as described in the
3.1 HW Setup Instructions and 3.2 Software Setup are done,

1. Turn on [M6]-SW2. [M6]-LD1, [M6]-LD2 and [M5]-LD1 will glow green indicating bias power is being generated.
[M5]-LD2 will start blinking indicating the PV emulator code is running on the emulator.

2. Inthe project window on the left, click the plus sign (+) to the left of Project, Fig 18. Open and inspect SolarExplorer-
Devinit_F2803x.c by double clicking on the filename in the project window. Note that system clock, peripheral clock
prescale, and peripheral clock enables have been setup. Next, notice how the shared GPIO pins have been
configured.

3. Open and inspect SolarExplorer-Main.c. Notice the call made to Devicelnit() function and other variable
initialization. Also notice code for different incremental build options, the SGEN initialization, PID initialization,
SineAnalyzer initialization etc.

4. Locate and inspect the code in the main file under initialization code. Observe macros used for EPWM module
initialization (PWM_1phinv_unipolar_CNF) and ADC module initialization (ADC_SOC_CNF) blocks. This is common
for all incremental builds.



5. Also locate and inspect the following code in the main file under initialization code. This is where the ADC channels
for different feedback signals are assigned and the start-of-conversion triggers are programmed. This is also
common for all incremental builds. As Boost and Inverter are run at different frequencies and from different PWM,
the PWM synchronization feature is used to avoid any ADC conflicts as shown in Fig 12.

#define Iboostsw_FB AdcResult .ADCRESULTL1
#idefine Ilegl_fb AdcResult .ADCRESULT3
#define Ileg2_fb AdcResult .ADCRESULT4
#define Vboost_FB AdcResult .ADCRESULTS
#define Ipv_FB AdcResult .ADCRESULT6
#tdefine Vpv_FB AdcResult .ADCRESULT7
#define Vac_FB AdcResult .ADCRESULTS
#define VN_FB AdcResult .ADCRESULTY9
#define VL_FB AdcResult .ADCRESULTI10
#define LIGHT_FB AdcResult .ADCRESULT11

//Map channel to ADC Pin
// the dummy reads are to account for first sample issue in Rev 0 silicon
// Please refer to the Errata and the datasheet

ChSel[0] = 14; // B6 — Iboostsw-FB

// DC-DC Boost switch current, not routed on Rev 1, dummy read
ChSel[1l] = 14; // B6 — Iboostsw-FB

ChSel[2] = 4; // A4 - Ilegl,

ChSel[3] = 4; // A4 - Ilegl,

ChSel (4] = 6; // A6 — Ileg2,

ChSel[5] = 2; // A2 — Vb_FB, DC DC Boost Output Voltage
ChSel[6] = 0; // A0 — Ipv_FB, Panel input current
ChSel[7] = 1; // Al - Vpv_FB, Panel input Voltage
ChSel[8] = 7; // A7 - Vac-fb

ChSel[9] = 5; // A5 — VN-fb

ChSel[10]= 9; // Bl - VL-fb

ChSel[1l1l]= 8; // BO — Light-fb

// Select Trigger Event

TrigSel[0]= ADCTRIG_EPWM3_SOCA;
TrigSel[1l]= ADCTRIG_EPWM3_SOCA;
TrigSel[2]= ADCTRIG_EPWM1_SOCA;
TrigSel[3]= ADCTRIG_EPWM1_SOCA;
TrigSel[4]= ADCTRIG_EPWM1_SOCA;
TrigSel[5]= ADCTRIG_EPWM3_SOCA;
TrigSel[6]= ADCTRIG_EPWM3_SOCA;
TrigSel[7]= ADCTRIG_EPWM3_SOCA;
TrigSel[8]= ADCTRIG_EPWM1_SOCA;
TrigSel[9]= ADCTRIG_EPWM1_SOCA;
TrigSel[10]= ADCTRIG_EPWMI1_SOCA;
TrigSel[11]= ADCTRIG_EPWM1_SOCA;

6. Navigate to the portion of the code which has inverter ISR code (Inv_ISR()) inside SolarExplorer-Main.c. Inside the
ISR, code for multiple build options can be found. Notice that for Build 1 InvSine parameter is calculated by sgen
block. Macro used for driving PWM outputs is PWMDRV_1phinv_unipolar. Open this macro and observe how the
PWM outputs are driven for the inverter stage.



Build and Load the Project

7. Select the incremental build option as 1 in the SolarExplorer-Settings.h file.
Note: Whenever you change the incremental build option in SolarExplorer-Settings.h always do a “Rebuild All”.

8. Click Project = “Rebuild All” button and watch the tools run in the build window.
9. Click Target > "Debug Active Project”. The program will be loaded into the flash. You should now be at the start of
Main().

Debug Environment Windows

10. It is standard debug practice to watch local and global variables while debugging code. There are various methods
for doing this in Code Composer Studio, such as memory views and watch views. If a watch view did not open
when the debug environment was launched, open a new watch view and add various parameters to it by following
the procedure given below.

e Click: View »> Watch on the menu bar.

e Click the “Watch (1)" tab at the top watch view. You may add any variables to the watch view. In the empty
box in the "Name" column, type the symbol name of the variable you want to watch and press enter on
keyboard. Be sure to modify the “Format” as needed. The watch view should look something like the
following in Fig 22.

4 \Watch (1) X B %% &@e g8

Local (1)

Value Address Type Format
(9= ClearInvTrip i} 0x0000830F @Data int Matural
(9= YrmsReal 0.0 Ox00003 366 @0ata long Q-value(15)
(9= CloselloopIny i} 0x00003313@0ata int Matural
(%)= Gui_vboost 11.390625 Ox00008 340 @0ats ong Q-value(s)
= [B pidGRANDO_Tinv Lok Ox00008500@Data struct unknown Matural
= lfg term Lok Ox00008500@Data struct unknown Matural
()= Ref 0.0 Ox00005500@Data long Q-value(24)
()= Fbl 0.001953125 0x000058502@0Data long Q-value(24)
(= Out 0.0 Ox00003504@0ata long Q-value(24)
(=1 0.0 0x00003506@0ata long Q-value(29)
()= c2 0.0 0x00008503 @0ata long Q-value(29)
g param Tk 0x0000850A@0ata struct unknown Matural
g data Tk 0x00008513@0ata struct unknown Matural
(9= Gui_LightCommand 0.3992023438 Ox00003344@0ata long Q-value(13)

Fig 22 Snap shot of CCS Watch Window for Build 1

Using Real-time Emulation

Real-time emulation is a special emulation feature that allows the windows within Code Composer Studio to be updated
at a rate up to 10 Hz while the MCU is running. This not only allows graphs and watch views to update, but also allows
the user to change values in watch or memory windows, and see the effect of these changes in the system. This is very
useful when tuning control law parameters on-the-fly, for example.

11. Enable real-time mode by hovering your mouse on the buttons on the horizontal toolbar and clicking button



12.

13.

) 7 Enable Silicon Real-time Mode (service critical interrupts when halted, allow
debugger accesses while running)

A message box may appear. If so, select YES to enable debug events. This will set bit 1 (DGBM bit) of status
register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit. When the DGBM bit is set to “0”, memory and
register values can be passed to the host processor for updating the debugger windows.

)
Click on Continuous Refresh buttons 5~ for the watch view.

Run the Code

14.

15.

16.

17.

18.

19.

20.

21.

Make sure the bulb load is connected at the output of the inverter, alternatively a resistive load (5-10 ohms) can be
connected across the inverter output terminal block TB1 of [M2], when using external resistor load for the inverter
remove the bulb load.

Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target > Run on the menu
bar.

In the watch view, check the value of Gui_LightCommand, it will read _1Q13(0.19), this is the light command for the
panel emulator. As DC-DC Boost stage is not switched in this level it passes the input of the panel voltage with a
diode drop. Thus Gui_Vboost which is the DC bus for the inverter as the DC-DC boost output is connected to the
DC-AC inverter, will read ~_1Q9(5.7) Volts.

Now change the Gui_LighCommand to _1Q13(0.4), the Gui_Vboost will now read ~_1Q9(11.38).

Add the variable inv_Iset and set it to 0.3 (Q24). This variable sets the current command for the inverter closed
loop operation.

Add ClearinvTrip, Closellooplinv flag to the watch window. Write “1” to both these variables, to turn on the inverter
and to enable inverter operation in closed loop. ClearInvTrip will return back to ‘0’ value once the command to clear
the initial trip is acknowledged.

Observe inverter output on the oscilloscope by probing the test point on the board using a scope probe at (Vac-FB,
PWM-H1 and PWM-H2 on [M2]),

Fig 23 shows a captured plot of these signals along with the output voltage Vac-FB. Note that one PWMs are
modulated in unipolar fashion, with one set H/L PWMs switching in one half cycle and other set in the other half
cycle.
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Fig 23 Unipolar Modulation for full bridge inverter, Chl: Vac-FB, Ch3: PWM-H1, Ch4: PWM-H2

22. Monitor inverter leg currents, marked as lleg1-fb and lleg2-fb on the board, on oscilloscope to ensure that the
current feedback is fed to the controller as expected. Fig 24 shows oscilloscope capture of these waveforms.

Chl 200mv * M10.0ms A Chl & 100my
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Fig 24 Inverter Current Measurement




23. Now connect the scope probes to the PWM-DAC outputs to verify closed loop operation of the inverter, [Main]-J5,
PWMDACH1,3,4 are connected to plot the signal generator output, the instantaneous measured current and the
reference current signal respectively.
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Fig 25 Closed Loop Inverter Operation, Chl: Sin Gen, Ch3: Measured Current, Ch4 : Current Reference

24. User can now slowly, in incremental steps of 0.05, change inv_Iset value from 0.2 to 0.4 in the watch window. User
can observe that the closed current loop operation is followed..

Observe the output voltage carefully, this should not be allowed to exceed the maximum voltage rating of
the board.

25. User can also vary the load resistance and see the effect on the output voltage. In Build 1, inverter is operating in
closed loop current mode. Hence, current loop will always try to track inverter output current to the set reference
command (inv_Iset). As the load connected is resistive — output voltage is expected to vary such that current is
tracked to set reference.

26. Write 0 to inv_Iset in the watch window, followed by writing a zero to Gui_LightCommand. Fully halting the MCU

when in real-time mode is a two-step process. Now, halt the processor by using the Halt button on the toolbar =~
¥
or by using Target > Halt. Then take the MCU out of real-time mode by clicking on it } Finally reset the MCU
L
27. You may choose to leave Code Composer Studio running for the next exercise or optionally close CCS.

End of Exercise



4.2 BUILD=2
Inverter Current Control with DC Bus Regulation & DC-DC Boost MPPT Control

Objective:

The objectives of this build are, (1) Understand closed loop control of the Boost stage (2) Check MPP tracking under
varying panel conditions (3) Verify full system operation with DCDC Boost and inverter working in tandem. Under this
build the system runs in complete closed-loop mode for the Inverter power stage and DCDC boost stage. System is not
connected to the grid. Steps required for building and running a project are explained next.

Overview:

Build 2 focuses on closed loop control of the inverter and boost stages along with MPP tracking. For inverter control, in
addition to closed loop current control in Build 1, outer voltage loop is added. Voltage loop in the inverter stage is
responsible for setting the reference command for the current loop. Current reference reflects the amount of power that
can be transferred to the load depending on the instantaneous DC bus voltage. Details of the control mechanism can be

found under section 2.3 Control Description of this document. DC bus reference voltage (Vdcref), for the voltage loop,
is set to 30V for this Build.

Inverter stage feedback quantities are same as Build 1 — in addition, boost output voltage (Vboost_FB) is used for the
outer voltage loop of the inverter as shown in Fig 27. PWM configuration for the inverter remains the same as in Build 1
for the inverter stage. For the Boost stage, PWM signal is generated at a frequency of 100 kHz, and is configured to
operate in up-down count mode, PWMDRV_1ch_UpDwnCntCompl module from the digital power library is used to
configure the Boost PWM, Fig 26.
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Fig 26 DC-DC Boost PWM using PWMDRYV_1ch_UpDwnCntCompl Configuration

Boost switch current is sampled at the midpoint of the PWM ON pulse i.e. TBCTR=TBPRD. The panel current and
voltage are sensed at zero event, this uniformly distributes the ADC loading. The ISR trigger frequency is half that of the
PWM switching frequency as shown, this is done because the PV panel conditions don’t change very frequently. The
PWM time bases for DC-DC Boost and DC-AC inverter are synchronized to avoid conflict on the A/D converter. The
DC-DC Boost loop runs as 50Khz and the inverter loop runs at 20Khz. Note that Inverter ISR is made interruptible by
the DC-DC Boost interrupt and the code jumps to the Boost ISR and then returns back to the inverter ISR, as shown in
Fig 12.

Sampled values of panel voltage and current (Ipv, Vpv) are passed on to MATH_EMAVG block, a software module that
performs exponential moving average over data stored in Q24 format. Averaged values of Ipv, Vpv are then passed on
to MPPT algorithm. This version of the software uses Incremental Conductance algorithm for maximum power point
tracking. Both Incremental conductance(mppt_incc.h) and Perturb and Observe(mppt_pno.h) are available are library
components in controlSUITE under solar library (...\controlSUITE\libs\app_libs\solar) directory. User can choose to use
either of these algorithms to evaluate performance and measure MPPT efficiency. MPPT algorithm generates reference
voltage command for the outer voltage loop of the boost stage.
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Fig 27 Software Diagram for Build 2



Procedure

Assuming the user if following from the Build-1 the hardware setting as described in the

3.1

HW Setup Instructions and 3.2 Software Setup will already be done,

Turn on [M6]-SW2, if not already on. [M6]-LD1, [M6]-LD2 and [M5]-LD1 will glow green indicating bias power is
being generated. [M5]-LD2 will start blinking indicating the PV emulator code is running on the emulator.

The connection of the digital power library blocks to implement the DC-DC Boost with MPPT is illustrated in 2.3

Control Description -> DC-DC Boost with MPPT Control Software . Further Locate and inspect the following
code in the main file under initialization code (SolarExplorer-Main.c). This is where coefficient buffers for 2P2Z
modules used in Boost stage control software are initialized. Also, look for mppt module initialization code in the
same file.

// Coefficients for Outer Voltage Loop

// PID coefficients & Clamping - Current loop (Q26)
Dmax_V = _I024(0.9);

Pgain_V _I1026(0.015);

Igain_V _I026(0.00005);

Dgain_V =_I026(0.0);

// Coefficient init ——— Coeeficient values in Q26

CNTL_2P27_ CoefStructl.b2 =Dgain_V; // B2
CNTL_2P2Z_CoefStructl.bl =(Igain_V-Pgain_V-Dgain_V-Dgain_V); // Bl
CNTL_2P2Z_CoefStructl.b0 =(Pgain_V + Igain_V + Dgain_V); // BO
CNTL_2P27_CoefStructl.a? =0.0; // B2 =0
CNTL_2P2Z_CoefStructl.al = TQ026(1.0); // Al =1
CNTL_2P2%_CoefStructl.max =Dmax_V;

//Clamp Hi

CNTL_2P27_CoefStructl.min =_IQ24(0.0); //Clamp Min

// Coefficients for Inner Current Loop
// PID coefficients & Clamping - Current loop (Q26)

Dmax_I = _I024(0.9);

Pgain_ I = _I026(0.015);

Igain_I = _IQ26(0.00005);

Dgain_I =_T10Q026(0.0);

// Coefficient init ——— Coeeficient values 1in Q26
CNTL_2P27_CoefStruct2.b2 =Dgain_TI; // B2
CNTL_2P27_CoefStruct2.bl =(Igain_I-Pgain_I-Dgain_I-Dgain_I); // Bl
CNTL_2P27_ CoefStruct2.b0 =(Pgain_I + Igain_I + Dgain_I); // BO
CNTL_2P27_ CoefStruct2.a2 =0.0; // A2 =0
CNTL_2P27_CoefStruct2.al =_1026(1.0); // Al =1
CNTL_2P2%_CoefStruct2.max =Dmax_1I;

//Clamp Hi

CNTL_2P27_CoefStruct2.min =_IQ24(0.0); //Clamp Min

// Initialize the net variables

Duty3A =_I0Q024(0.0);

VboostRead=_1024(0.0);

IboostswRead=_10Q024(0.0);

VpvRef=_T1Q24(0.9); // to increase current, we need to reduce VpvRef, thus
initailize it with a high value.

IboostSwRef= _T1024(0.0);



Duty3A_fixed=_IQ24(0.2);
VpvRead_EMAVG=_TI0Q24(0.0
0

0
IpvRead_ EMAVG=_IQ24 (0.

)i
).

4

// MPPT testing related code
// mppt incc

mppt_inccl.IpvH = _IQ(0.0001);
mppt_inccl.IpvL = _IQ(-0.0001);
mppt_inccl.VpvH = _IQ(0.0001);
mppt_inccl.VpvL = _IQ(-0.0001);
mppt_inccl.MaxVolt = _I0(0.9);
mppt_inccl.MinVolt = _IQ(0.0);
mppt_inccl.Stepsize = _IQ(0.005);

mppt_inccl.mppt_first=1;
mppt_inccl.mppt_enable=0;

//mppt pno

mppt_pnol.DeltaPmin = _IQ(0.00001);
mppt_pnol.MaxVolt = _I0(0.9);
mppt_pnol.MinVolt = _IQ(0.0);
mppt_pnol.Stepsize = _IQ0(0.005);

Also open the SolarExplorer-DPL_ISR.asm and inspect its contents. This file consists of the real time ISR code for
the DC-DC Boost, notice the macros used for ADC result reading, execution of control code (2P2Z modules) and
PWM drivers used for driving the boost PWM switch.

_DPL ISR:
; context save
ADCDRV_1ch 1
ADCDRV_1ch 5
ADCDRV_1ch 6
ADCDRV_1ch 7
CNTL_2P27Z 1
CNTL_2P27Z 2
PWMDRV_1ch_UpDwnCntCompl 3 ; PWM3A
MATH_EMAVG 1
MATH_EMAVG 2
;context restore
IRET

Now go to task B1 in the Main.c file and inspect the MPPT usage. Task B1 is repeatedly called from the Main.c
background framework, the frequency at which this task is called is determined by the value written to the
CpuTimer1Regs.PRD.all register in the beginning of the main code. The task consists of both the usage of
mppt_incc and mppt_pno algorithms, the user may comment may choose to use either. An LED is also blinked on
the controller when the MPPT task is enabled. The MPPT execution is further slewed in software by variable
MPPT_slew. MPPT _incc is used as default in this lab exercise.

// MPPT routine

mppt_inccl.Ipv = IpvRead_EMAVG; //IpvRead;
mppt_inccl.Vpv = VpvRead_EMAVG; //VpvRead;
mppt_incc_MACRO (mppt_inccl) ;

VpvRef_ MPPT = mppt_inccl.VmppOut;



mppt_pnol.Ipv = IpvRead_EMAVG; //IpvRead;
mppt_pnol.Vpv VpvRead_EMAVG; //VpvRead;

mppt_pno_MACRO (mppt_pnol) ;

// VpvRef_MPPT = mppt_pnol.VmppOut;

5. For build 2, software goes through a state machine, listed below, before turning on the inverter output. This state

machine is described in task B3.

e Inverter State ==0 , wait for the command to start production of power (Gui_InvStart==1)

e Inverter State ==1, Check if panel voltage is available, i.e. Vpv > 3V, if true enable MPPT

e Inverter State ==2 , Now as the MPPT algorithm kicks in the capacitors between the DC-DC and DC-AC will
start storing the energy from the panel and the voltage of these caps will rise, Now check if Gui_Vboost > 30V
and enable inverter closed loop operation to regulate the DC bus and the current on.

e Inverter State ==3, The inverter is now ON and producing power, the power delivered will change as the
Gui_LightCommand value is changed. Now the system waits for stop command (Gui_InvStop==1), if stopped,
trip all PWM's, shut down MPPT and return to state 0, reset all values

Build and Load the Project
6. Open SolarExplorer-Settings.h and set build option as 2.
7. Click Project = “Rebuild All” button and watch the tools run in the build window.

8. If the debug session is still on you may be asked to just reload the updated image, otherwise Click Target > "Debug
Active Project”. The code shall now be halted at the beginning of the Main function.

9. Setup the Debug Environment Windows as in and Enable real time option (see build 1 for detailed instruction).

“* Watch (1) X El ® | (@& Y 7O

Mame Value Address Type Format
()= Gui_Invstart ] Ox00008320@0ata  unsigned int Matural
()= Gui_InvStop [} Ox00003323@0ata  unsigned int Matural
(9= Gui_LightCommand 0,199951171% Ox00003344@0ata  long Q-Value(13)
()= Gui_PanelPower 0.0 Ox0000333E@Data long Q-Value(d)
()= Gui_PanelPower_Theoretical 7. 173328125 Ox00003343@0ata  long Q-Value(s)
(<= Gui_Vpv 5663321375 0x00008344@Data  long Q-valus(g)
()= Gui_Ipv 0.02085546875 Ox00003352@0ata  long Q-value{12)
()= Gui_Vboost 5. 705073125 Ox00003340@0ata  long D-values(g)

___q

Fig 28 Build 2 CCS Watch Window setup

Run the Code

10. Run the code by using the <F8> key, or using the Run button on the toolbar O

menu bar.

, or using Target > Run on the



11. Observe the Gui_LightCommand Value in the watch window this shall be _1Q13(0.2). This value determines the
curve that the panel emulator uses for interpolation of the V vs | curve under different lighting conditions. Any
changes to this value are communicated through SPI to the F28027 controller that implements the PV panel
emulator. A table with V vs | characteristic is stored corresponding to the Gui_LightCommand value of _1Q13(1.0)
and the points are linearly interpolated for a different luminance level.

v G2

— T %k
pv_ref _G2 T Gl 14

pv_ref

The Fig 29 shows the panel emulator characteristic with changing luminance, note these are not exactly the same
as a real panel but are useful for a quick illustration of MPPT and Solar Powered Inverter.

Panel Emulator Characteristic Power Vs Voltage at different Luminance Levels, Uoc=28 V. 1sc=3.0 Amp. Umpp=18 V. Impp=2.0 Amp
40 T T T T T

18
Panel Valtags

Fig 29 Panel Emulator Characteristic

Table 1 Panel Emulator MPP voltage and power with Changing Luminance

Luminance Ratio Pmpp Vmpp
(w.r.t 1000W/m~2) =(Pmax * Luminance Ratio) (Volts)
Watts
1.0 =1000 W/m"2 36.02 18.46
0.9 = 900W/m~"2 32.42 16.42
0.8 = 800W/m~"2 28.82 14.68
0.7 =700W/m"2 25.22 12.77
0.6= 600W/m"2 21.61 10.98
0.5=500W/"2 18.01 9.093
0.4=400W/m"2 14.41 7.363
0.3=300W/m"2 10.81 5.473

0.2=200W/m*2 7.205 3.67



12.

13.

14.

15.

16.

In the watch window notice the value of Gui_PanelPower_Theoretical which will be _1Q9(7.205)corresponding to
the table listed above.

Now change the value of Gui_InvStart to 1, the state machine will now kick in. MPPT will be enabled and the DC
bus will start rising and as it reached 30V the inverter close loop operation will be started. The state can also be
monitored by watching the variable PVinverterState in the watch window. Note the Gui_PanelPower, which shall
now be close to the theoretical value. This shows the tracking of the MPPT from a cold starts.

Now change the Gui_LightCommand set to 0.4, The Gui_PanelPower_Theoretical will now change to _1Q9(14.41),

as MPPT is on the Gui_PanelPower is tracked close to 14.41W and Gui_PanelVoltage reaches close to 7.363V.
Now the system is operating at Maximum Power Point for the given Gui_LightCommand as shown in the table
above, illustrating MPPT tracking uder varying lighting condition.

The user can now change the value of the Gui_LightCommand in increments or decrements of 0.1 between
_1Q13(0.2) to _1Q13(0.8) and under each condition ensure that the system is tracked to the MPP. Once the
Gui_LightCommand is changed it takes a few seconds for the system to track to the new Maximum Power Point
under the changed Luminance conditions. Check the observed results with the expected results from Table 1 Panel
Emulator MPP voltage and power with Changing Luminance.

If LightCommand greater than 0.8 is desired the user must use a power supply of a higher rating than what is
supplied with the kit. This can be done by connecting an external power supply at [M6]-TB1 and depopulating the
jumper [M6]-J1.

MPPT efficiency can be measured using different metrics, one is Static Efficiency which is defined as how close
the panel power is to the theoretical power that can be extracted from the panel under given conditions. Dynamic
efficiency is determined by the speed with which MPP point is achieved under varying light conditions.

Screen shots of system parameters under various dynamic MPPT test are below:

Channel 1: Vpv
Channel 3: Vboost
Channel 4: lac_measured

oo 100my ; Al 200my
¥ : @ 3.50V

i 416ms
@: —-424ms ; @: —424ms

5.00V B M400ms, A Chl -5 100mVv 5.00V B M400ms A Chl S 100mV
9 Dec 2011 9 Dec 2011
13:50:55 13:53:58

Fig 30 Dynamic MPPT Luminance 0.2 -> 0.4 Fig 31Dynamic MPPT 0.4 -> 0.2




o 100my

5.00V & M 2.005| A Chl 5 100mv S.00V &y M 2.00s A Chl S 100mV

9 Dec 2011
14:02:08

Fig 32 Dynamic MPPT Luminance 0.2 -> 0.8 Fig 33 Dynamic MPPT Lumimance 0.8 >0.2

17. To end this exercise, write ‘0’ to Gui_LightCommand variable in the watch window, now write a ‘1’ to Gui_InvStop.
Fully halting the MCU when in real-time mode is a two-step process. Now, halt the processor by using the Halt

button on the toolbar -" , or by using Target > Halt. Then take the MCU out of real-time mode by clicking on
. Finally reset the MCU #

18. Close CCS debug session by clicking on Terminate Debug Session [ (Target->Terminate all).

19. Switch off the power to the board by moving [M6]-SW2 to off position.

End of Exercise



4.3 BUILD=3

Inverter Current Control with DC Bus Regulation & DC-DC Boost MPPT Control
& Grid Sync

Objective:

The objective of the build is to understand the operation of grid-tied PV Inverter system. Inverter closed current loop
along with DC bus regulation is run along with MPPT with DC-DC Boost stage. Software PLL is used for grid
synchronization and calculating the phase of the grid.

Overview:
The inverter stage on the Solar Explorer kit is rated for low voltages, hence to test connection with the grid a step down
transformer is used. Also the bulb used in build 1 and 2, as it has a very low resistance, is replaced with a resistive load

of 15 Ohms. Fig 34 shows the hardware setup for the BUILD 3. The AC Grid is stepped down to 14V AC, this can be
2
checked using a multimeter. At this voltage the power consumed by the load is, P,, = VRLLC , when the inverter is off all the

power to the load is provided by the grid current i.e. ig,.;q. As the inverter starts producing power the load current is
shared by the PV inverter and the grid i.e. ig; = igiq + iy, - As the power produced from the inverter increases the
entire load current is supplied by the inverter and the surplus is fed back into the grid. This is observable from the phase
of the grid current w.r.t to the grid voltage.

Stepped Down
AC grid

Current Probe Current Probe

PV Panel
Emulator
(Solar
Explorer)

Step Down
Transformer
With Isolation

Solar Explorer AC Grid

Load

Fig 34 Hardware Setup for Grid Connection Test with SolarExplorer

Control for this build is similar to Build 2, with an addition of software PLL block integration which is used to determine
the phase of the grid instead of the SGEN block. Sine analyzer block is added to determine the RMS voltage of the grid
and ZCD determination.
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Fig 35 Software Diagram for Build 3



Procedure

Following sections detail the hardware setup and steps to connect CCS perform objectives for build 3.

Hardware set up for Build 3:

socked located in [M2] macro (Caution, the bulb may be hot!).

Fig 36 shows the hardware settings for

with the gird as shown in the Fig 36.

[M7]-J4 —

[Main]-J4—
[Main]-J1, _.

J2,J3
Isolation
Transformer

n@ a ] %

AutoTrans
former

Current
probes

the Build 3 test.

[M7]-JP1 USB [M6]-JP1 DC
Cable to Host Power Jack

Assuming the hardware setting for build 2 is present, and the board is not powered. Take out the bulb from the

Verify SW1 on [M6] is in on position. Now turn on power to the board [M6]SW2 to ON position.

[M6]-SW2 (On/Off)
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Fig 36 Hardware Setting for Build 3

Make sure Bulb
is removed

First move the autotransformer to 0 setting and make connection with the resistive load and the solar explorer board

M6]-SW1 in ON position

anana cable

" [Main]-BS1 to

[Main]-BS3




Start CCS and Open a Project

1. Also locate and inspect the following code in the main file (SolarExplorer-Main.c) under inv_isr() for Build 3. This is
where the software PLL is instantiated. PLL takes grid voltage reference (Vac_FB ) and generates sine of the grid
angle (spll1.Mysin[0]) in Q21.

// PLL Start
Vac_in=(long) ( (long)Vac_FB<<9)-0ffset_Volt; // shift to convert to Q21
splll.AC_input=Vac_in;
SPLL_run(&splll);
InvSine = (long) (splll.Mysin[0])>>6; // InvSine is in Q15
// Voltage loop
PidGRANDO_Vinv.term.Fbk = _I024(0.75); // 30vV/ 39.97
pPidGRANDO_Vinv.term.Ref = VboostRead; //Ref=VDC/sqrt(2) at full modulation index
if (CloseVloopInv==1 && sine_mainsV.ZCD==1)
{
PID_GR_MACRO (pidGRANDO_Vinv) ;
inv_Iset=pidGRANDO_Vinv.term.Out;
}
if (ResetPLL==1)
{
SPLL_init (60,_I021(0.00005),&splll); // Q20
ResetPLL=0;
}
2. For build 2, software goes through a state machine, listed below, before turning on the inverter output. This state

machine is described in task B3.

Inverter State ==0 , Wait for inverter start command (Gui_InvStart==1)

Inverter State ==1 , Check grid voltage, i.e. Vrms Real > _1Q15(12)

Inverter State ==2 , Check if panel voltage is available, i.e. Vpv > 3V, if true enable MPPT

Inverter State ==3, Now as the MPPT algorithm kicks in the capacitors between the DC-DC and DC-AC will
start storing the energy from the panel and the voltage of these caps will rise, Now check if Gui_Vboost > 30V
and enable inverter closed loop operation to regulate the DC bus and the current on.

Inverter State ==4, Wait for the current command to be of significant value (this is primarily done as a safety
measure), then clear the initial inverter trip.

Inverter State ==5, The inverter is now ON and producing power, the power delivered will change as the
Gui_LightCommand value is changed. This will also change the power sourced from the grid. The system waits
for stop command (Gui_InvStop==1), if stopped, trip all PWM's, shut down MPPT and return to state 0, reset all
values

Build and Load the Project

3.

oo

Select the incremental build option as 3 in the SolarExplorer-Settings.h file.

Note: Whenever you change the incremental build option in SolarExplorer-Settings.h always do a “Rebuild All”.

Click Project > “Rebuild All” button and watch the tools run in the build window.
Click Target > "Debug Active Project”.



Debug Environment Windows

Enable real time options —same as Build 1 and 2. Also add the watch variables as shown in Fig 37

“< Watch (1) X B X% $Be v "0

Value Address Type Format
= Gui_ InvStart _m
()= Gui_InvStop Ow00003323@0ata unsigned int Matural
()= Gui_LightCommand 0, 1999511719 Ox00003344@0ata  long Q-Value(13)
()= Gui_PanelPawer 7.01171875 Ox0000833E@0ata  lang Q-Value(d)
()= Gui_PanelPower_Theoretical  7.173328125 Ox00003343@0ata long Q-Value(s)
9= Gui_Vpv 3.662109375 Ox0000334480ata  long 0-Yalue(s)
()= Gui_Ipv 20522496094 Ow0003352@0ata  long 2-Yaluel12]
()= Gui_Vboost 29,95875 Owd0003340@0ata  long 2-Value(=
()= PyInverterstate g 000003302 @Data  int Matural
()= ResetPLL 0 Ow0000330E@Data  int Matural
()= YrmsRes 12.93426514 Ow0003366@0hata  long Q-Valuel15)
()= mppt_incc 1, Stepsize 0004399995232 Ow000084%0@Data long Q-Value(24)

Fig 37 Build 3 CCS Watch Window setup

Run the Code

6. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target = Run on the menu
bar.

7. Now make the following connection to the oscilloscope to observe different variables in the subsequent exercises.

Channel 1: Grid Voltage (measured PWMDAC)

Channel 2: PLL lock (calculated PWMDAC)

Channel 3: Grid Current (measured with current probe on the connector from step down transformer to load)
Channel 4: Inverter current (measured using current probe placed on the connector from TB1 to load)

8. Checking Grid Synchronization: Now as the code is running, first thing to check is if the PLL is operating
correctly. For this two channel from the PWMDAC are used (PWMDAC1 and PWMDAC?2), on which the SPLL out
and the input AC voltage measured are plotted. Note as autotransformer is currently at zero setting the SPLL will be
getting reset again and & again as there is no AC to lock to. Now gradually increase the AC voltage by moving the
auto transformer position from the zero position. The SPLL out will be locked to the output voltage of the inverter.
The waveform will be similar to as shown in figure below
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Fig 38 Grid Synchronization using SPLL

Move the autotransformer to the point such that the VrmsReal reads close to _IQ15(14.0).

Load Power = Power From Inverter + Power From Grid, Now for a load resistance of 15 Ohms and Grid Voltage
(Vrms) of 14V, load current requirement would be Irms 0.933Amps. Total Power dissipated in the load is 13W. At
the start the Gui_LightCondition has a value of 0.2 which corresponds to theoretical power maximum of 7.2W.
Therefore once the inverter is turned on, under these conditions, inverter will deliver close to 7.2W (Luminance
Ratio of 0.2), and remaining power requirement for the load will be provided from the grid.

Verify that the Gui_LightCondition value is 0.2 in the watch window, Now change the value of Gui_InvStart to 1, the
state machine will now kick in. MPPT will be enabled and the DC bus will start rising and as it reached 30V the
inverter close loop operation will be started. The state can also be monitored by watching the variable
PVinverterState in the watch window. Note the Gui_PanelPower, which shall now be close to the theoretical value.
This shows the tracking of the MPPT from a cold start. Fig 39 Shows the current waveform with the inverter and the
grid current, as they are almost in phase this shows the currents from the two sources i.e. the grid and the PV
inverter sum together to provide the required current for the load.
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Fig 39 Load Power = Power From Inverter + Power From Grid, Vrms ~15-16V, Rl ~15 Ohms




11. Power From Inverter = Load Power + Power Fed Into the Grid, Now change the Gui_LightCommand set to 0.8,
The Gui_PanelPower_Theoretical will now change to _1Q9(28.7), as MPPT is on the Gui_PanelPower is tracked
close to 28.7W. Now as the inverter has surplus power that, it starts feeding power into the grid. This reversal in
power flow is characterized by the phase change in the grid current Fig 41 w.r.t the inverter current as compared to
the previous case of Fig 39.

Trig‘d

’\/\/‘

Chl 2.00V % M20.0ms A Chl £ B0.0mV

16 Dec 2011
i+~ 0.00000 s 14:02:53

Chl 200V~ M20.0ms A Chl - B0.0mV

16 Dec 2011
+¥ 0.00000 s 14:02:10

Fig 41 Load changed(reduced) w.r.t. Fig 40,
Note the power from the inverter remains the same, the power fed to the grid increases, Vrms ~15-16V, Rl ~30 Ohms

12. The user can now change the value of the Gui_LightCommand in increments or decrements of 0.1 between
_1Q13(0.2) to _1Q13(0.8) and under each condition ensure that the system is tracked to the MPP and how the grid
current changes as each level. Once the Gui_LightCommand is changed it takes a few seconds for the system to
track to the new Maximum Power Point under the changed Luminance conditions. Check the observed results with
the expected results from Table 1 Panel Emulator MPP voltage and power with Changing Luminance.



13.

14.

15.
16.

To end this exercise, write a ‘1’ to Gui_InvStop, now bring the auto transformer to the zero voltage position and
write a ‘0’ to Gui_LightCommand variable in the watch window.

Fully halting the MCU when in real-time mode is a two-step process. Now, halt the processor by using the Halt

button on the toolbar =" , or by using Target > Halt. Then take the MCU out of real-time mode by clicking on
. Finally reset the MCU - |

Close CCS debug session by clicking on Terminate Debug Session .| (Target->Terminate all).

Switch off the power to the board by moving [M6]-SW2 to off position.

End of Exercise



